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1. INTRODUÇÃO 
 
   O que aprenderei nesta atividade? 
   Você aprenderá na prática como os astrônomos calculam a magnitude de uma estrela através de 
imagens obtidas com câmeras CCD. Treinaremos o uso do software de processamento de imagens.  
 
   A seguir, estão alguns conceitos iniciais importantes 
   Quando você observa estrelas com seus olhos, ou com um telescópio, você está recebendo uma luz 
que viajou grandes distâncias. É curioso notar que muitas vezes a luz permanece não afetada durante os 
primeiros 99.999999999999% de sua jornada. Entretanto, na passagem pela atmosfera da Terra, e 
mesmo através do instrumental óptico do telescópio, a luz pode finalmente ser alterada causando uma 
diferença no brilho de uma estrela, de uma observação para a outra. 
   Fotometria é o processo de medir a quantidade de luz recebida de um objeto. Os astrônomos usam a 
fotometria para medir variações de brilho de um objeto como uma estrela variável ou uma supernova. 
Para medir variações, imagens de uma mesma estrela são tomadas em noites sucessivas e as suas 
contagens são comparadas com aquelas de uma estrela de brilho não variável. Um outro motivo para 
usar fotometria é medir o brilho aparente de uma estrela, tendo em vista o cálculo de sua distância. Isso 
será feito numa futura atividade. Esse método envolve a calibração com uma estrela padrão. A seção 
Técnicas Fotométricas Utilizando o DS9 explica cada um desses processos. Algumas palavras usadas 
em fotometria são definidas a seguir: 
 
Contagem: Intensidade de luz proveniente da estrela, recebida em cada pixel do CCD. Essa medida 
depende do equipamento utilizado e das condições atmosféricas durante a observação. Quando uma 
imagem é apresentada na tela, o brilho de cada pixel vai depender da contagem medida nesse pixel. 
Luminosidade: A porção de luz emitida por uma estrela, por unidade de tempo (segundo). É uma 
propriedade inerente da estrela e não depende de onde ou como as observações foram feitas. 
Geralmente a luminosidade da estrela não pode ser medida diretamente, mas deve ser inferida a partir 
das características da estrela. As unidades para luminosidade são Watts (Joules/segundo). 
Brilho aparente: A porção de luz que chega na Terra, por segundo, sob condições ideais (caso não 
houvesse atmosfera). Este é um número padrão que qualquer pessoa observando uma estrela em 
qualquer parte da Terra poderia obter a partir de suas medidas, depois de corrigir as mudanças causadas 
pelas condições observacionais. As unidades para brilho aparente são Watt/metro2. 
Estrela de referência: Uma estrela cujo brilho aparente e luminosidade não mudam de uma noite para 
a outra. Geralmente, o brilho aparente dessa estrela não é conhecido. 
Estrela Padrão: Uma estrela não variável, cujo brilho aparente é bem determinado e conhecido. 
Magnitude aparente: A medida de brilho aparente mais usada em astronomia. A escala de magnitude 
é inversa, significando que estrelas mais brilhantes têm os menores valores de magnitude. 
Magnitude Absoluta: Essa quantidade é análoga a luminosidade, mas expressa numa dada escala de 
magnitude. 
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2. MEDINDO VARIAÇÕES DE BRILHO 
 
   Suponha que você tem imagens de uma mesma região do céu, obtidas em duas noites diferentes. A 
região contém duas estrelas. Uma é sua estrela alvo, aquela que você escolheu para estudar. A outra 
estrela é conhecida como tendo luminosidade constante, significando que o brilho da estrela não muda 
de uma noite para a outra. Ela é chamada a estrela de referência. Você não precisa conhecer o brilho 
exato dessa estrela, apenas que ele permanece constante. Para imagens de objetos pertencentes à nossa 
Galáxia, são escolhidas estrelas que se encontram na mesma linha de visada, entre o observador e o 
objeto em estudo. Se as condições de observações não mudassem de uma noite para a outra, a estrela de 
referência teria o mesmo brilho em ambas imagens. Se a segunda noite for mais clara que a primeira, a 
estrela de referência na segunda imagem será mais brilhante que na primeira. A estrela alvo pode 
parecer mais brilhante ou mais fraca numa das imagens, mas enquanto as correções devidas às 
mudanças nas condições de observação não forem levadas em conta, não fica claro se a mudança no 
brilho da estrela alvo é causada por diferentes condições observacionais ou mudanças na própria 
estrela. 
   Uma forma de determinar a variação de brilho da estrela alvo é medir a razão de contagens medida 
para a mesma, com relação a estrela de referência em cada imagem. Essa relação é chamada razão de 
contagens = Ca/Cr ; 
onde Ca é a contagem medida para a estrela alvo e Cr  para a estrela de referência. A razão de 
contagens dá diretamente o quanto a estrela alvo é mais (ou menos) brilhante que a estrela de 
referência. 
 
3. CALIBRAÇÃO PARA ENCONTRAR BRILHO APARENTE 
 
   Cada vez que você faz uma observação, as condições atmosféricas podem mudar, afetando a porção 
de luz que chega no telescópio. Você precisa de  um procedimento para encontrar o brilho de uma 
estrela, que é independente das condições observacionais. Além disso, cada CCD recebe a luz de forma 
diferente levando a diferentes números de contagens para um dado brilho, desta forma as contagens não 
são quantidades úteis quando se compara imagens de um telescópio com as de um outro. Para usar seus 
dados no contexto de outras observações e tabelas de referência, você precisa determinar o brilho da 
estrela em unidades que sejam independentes de um CCD em particular. 
   A calibração permite lidar simultaneamente com mudanças nas condições observacionais e diferentes 
CCDs. O processo de calibração envolve uma imagem da estrela cujo brilho você quer medir e uma 
outra imagem de uma estrela padrão. Ela deveria estar na mesma região do céu que se encontra nossa 
estrela alvo, de forma que em todas as vezes ambas passarão pelas mesmas condições observacionais. 
Ajuda também ter uma estrela dentro da faixa ideal de brilho (nem brilhante demais, nem fraca demais) 
para assegurar uma boa imagem. E mais importante, que a estrela padrão tenha seu brilho aparente já 
conhecido. 
   Dentro de condições observacionais idênticas para as estrelas alvo e padrão, a razão de suas 
contagens é igual a razão de seu brilho aparente. Sendo Ca as contagens medidas para a estrela alvo, Cp 
as contagens para a estrela padrão, BBa o brilho aparente para alvo e BpB  o brilho para a padrão, então: 
Ca/Cp = Ba/Bp ou Ca/Ba = Cp/Bp.  
 
   Nota importante: As imagens usadas nesse procedimento foram obtidas através do filtro vermelho 
(R). Esse filtro bloqueia a maior parte da luz, exceto a luz vermelha da parte visível do espectro. 
Quando nós calculamos o brilho aparente de uma estrela-alvo nós devemos lembrar que isso apenas 
se refere à quantidade de luz que está sendo emitida pelo filtro vermelho. 
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   Com condições idênticas de observações para uma estrela padrão e estrela alvo, a razão de suas 
contagens é igual à razão de seus brilhos aparentes.  
Vamos nomear as seguintes quantidades: 
Ca = medida das contagens para a estrela alvo 
Cp = medida das contagens para a estrela padrão 
BBa = brilho aparente da estrela alvo 
BBp = brilho aparente da estrela padrão 
 

Desta forma:  
 

Ca / Cp = Ba / Bp   ou  Ca / Ba = Cp / Bp 

 
   Reescrevendo as expressões acima de forma a encontrar o brilho aparente da estrela alvo em termos 
do brilho aparente da estrela padrão e das medidas das contagens para as estrelas padrão e alvo, temos: 
 

BBa / Bp = Ca / Cp   de  modo que: BaB  = (Ca / Cp) Bp 
 
 
4. QUESTÕES A SEREM RESPONDIDAS 

 

1. Qual é o brilho da estrela alvo 1 em contagens na primeira e na segunda imagem ? 
 

2. Qual é o brilho da estrela alvo 2 em contagens na primeira e na segunda imagem ? 
 

3. Liste alguma das razões de porque as contagens podem variar para essas estrelas nas duas imagens. 
 
4. Meça as contagens para a estrela padrão da mesma maneira que procedeu na atividade anterior com 
as estrelas alvo. 
 
5. A magnitude aparente da estrela padrão medida em um filtro R é de 12.4. Utilize a tabela de 
conversão de brilho (no Anexo 1) para encontrar o brilho aparente no filtro vermelho dessa estrela. 
 
6. Use as medidas das contagens da estrela padrão, da estrela alvo 1 e o brilho aparente da estrela 
padrão determinado no passo 5 para calcular o brilho aparente da estrela alvo 1 no filtro vermelho. 
Repita o processo para encontrar o brilho aparente da estrela alvo 2. 
 
7. Use a tabela de conversão de brilho para encontrar as magnitudes aparentes no filtro vermelho das 
estrelas alvo. 
 
8. Compare as diferenças de magnitudes encontradas nas duas imagens e comente os resultados. 
 

 
 

5. ATIVIDADES DE TÉCNICAS FOTOMÉTRICAS UTILIZANDO O DS9 



                                                           Telescópios na Escola  4

 

Recursos do DS9 utilizados 
 

O principal recurso utilizado para esta tarefa é aquele que permite a visualização direta e a 

exportação do mapa de intensidades em um arquivo na forma de matriz de dados (Pixel Table), 

feita a partir de um local indicado numa imagem. 

Paralelamente a isto serão utilizadas regiões para facilitar a identificação dos objetos em 

que será feita a fotometria. Também será utilizado o cursor em sua forma cruzada, o que fixará a 

leitura da tabela de píxeis em uma dada região. 

 

Identificando os objetos de interesse (Padrões no céu e posições relativas) 
 

A primeira coisa a ser feita é abrir os arquivos que contém os objetos padrões para 

calibração fotométrica. Nesta atividade, coincidentemente, tais objetos se encontram no mesmo 

arquivo onde estão os objetos alvo que pretendemos obter a fotometria. Os arquivos podem ser 

abertos individualmente, pois o processo que será feito em um independe do processo que será 

feito no outro, mas você pode achar conveniente trabalhar com os dois arquivos abertos. Dessa 

forma, utilize os procedimentos de abertura de arquivos como explicados nas tarefas anteriores. 

Muito provavelmente alterações na escala de apresentação da imagem sejam necessárias. 

Utilize os procedimentos de configuração da escala de níveis de intensidade e de cores conforme 

lhe seja conveniente. 

Em um primeiro momento, tudo pode parecer uma grande confusão de estrelas e espaços 

vazios. Neste tipo de atividade é que a velha idéia constelação pode facilitar o trabalho do 

astrônomo. Faça desenhos imaginários com as estrelas mais brilhantes do campo, ou com padrões 

que se destaquem do grande conjunto de estrelas. 

Para esta atividade foi fornecida uma imagem para ser utilizada como carta de localização 

(finding chart) de uma estrela padrão e de mais duas estrelas alvo. 

Em nosso exemplo, a estrela padrão que será tomada como referência para calibração 

fotométrica está próxima de outras duas estrelas, de aspecto muito semelhante a ela mesma, 

compondo um pequeno arco no céu. 
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Arco de Estrelas 

Figura 1: Carta de localização do campo de nosso exemplo. Repare no “arco” gerado pelas estrelas próximas à estrela 
padrão. Esta figura pode facilitar o reconhecimento da posição relativa das demais estrelas. 

 

Os diferentes aspectos que as estrelas apresentam na imagem nada têm haver com 

características intrínsecas delas (como luminosidade e tamanho). Tais aspectos são basicamente 

uma composição do brilho aparente da estrela e do efeito que a atmosfera exerce sobre a direção 

da luz, que acaba impondo rápidos e pequenos deslocamentos no feixe de luz, de modo que ela é 

registrada no detector como proveniente de diferentes direções, formando um disco conhecido 

como disco de seeing. 

 

     
Figura 2: Diferentes aspectos das estrelas da imagem em nosso exemplo. Ao aspecto circular associado às estrelas damos 

o nome de disco de seeing. 
 

Reconhecido um objeto na imagem (como a estrela padrão no topo do arco de estrelas), todas 

as demais ficam mais simples de serem reconhecidas por composições geométricas relativas a 

esta.  

 

Regiões marcando objetos de interesse 
 

Para demarcar os objetos de interesse, regiões quadradas devem ser utilizadas, acessando-

se a opção Region > Shape > Box e clicando-se sobre a estrela reconhecida. Dê dois cliques com o 
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botão principal sobre a região inserida e, na caixa de diálogo Box, ajuste o tamanho horizontal e 

vertical para 9 píxeis no campo Size e atribua um novo nome à região preenchendo o campo Text. 

Ajuste o posicionamento do quadrado sobre a imagem da estrela da mesma forma como foi feito 

na atividade sobre as luas de Júpiter. 

 

 
Figura 3: Inserindo e ajustando as configurações de uma região quadrada sobre a imagem. 

 
Repita os mesmos procedimentos para todas as demais estrelas indicadas na carta de 

localização. O aspecto final da imagem com as regiões sobrepostas deve ser o seguinte: 

 

 

“Dupla” de estrelas 
próximas 

Estrela brilhante mais 
próxima  após “dupla” 

de estrelas 

Base do “Arco” 

Estrela brilhante mais 
próxima  após base do arco 

Figura 4: Aspectos das regiões (quadrados com nomes) sobrepostas a imagem do campo de estrelas. As flechas e os textos 
em itálico sugerem uma metodologia de localização das estrelas Alvo a partir da estrela Padrão. 
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Salve um arquivo com a informação dessas regiões através da opção Region > Save 

Region... O formato do arquivo deve ser o do DS9/Funtools (Region > File Format > 

DS9/Funtools) e o sistema de coordenadas utilizado deve ser o da imagem (Region > File 

Coordinate System > Image). 

 

 
Figura 5: Salvando um arquivo com as regiões inseridas. 

 
Obtendo contagens sobre a imagem 
 

Sendo uma imagem um mapa de intensidades, os valores associados aos níveis de 

intensidade devem ser proporcionais ao número de fótons incidentes no detector numa dada 

direção. Vimos, no entanto, que a luz de um objeto não provém de uma única direção, mesmo 

quando o objeto não é extenso, sensibilizando uma área dentro do disco de seeing. Desta forma, 

para contabilizarmos o número de fótons incidentes de um certo objeto (fotometria = mensurar o 

número de fótons), precisamos somar as intensidades distribuídas no padrão de seeing e excluir as 

intensidades não associadas ao objeto que está sendo estudado (como a iluminação do próprio 

céu). 
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Com os recursos nativos do DS9 podemos obter a fotometria de um objeto de maneira 

bastante “manual”, o que não descarta o grande valor didático da tarefa nesta etapa, onde nos 

concentramos nas técnicas fotométricas. 

Como modelo, suporemos que a luz das estrelas que estudaremos se distribuem bem no 

interior de um quadrado de 9 píxeis (o que seria, aproximadamente, o disco de seeing). A 

metodologia de trabalho se segue nas seções subseqüentes. 

 

A tabela de píxeis 
 

O painel de informações básicas fornece constantemente o número de contagens no píxel em 

que se encontra o ponteiro do mouse. A idéia básica da aplicação do DS9 para fotometria baseia-se 

na soma de todas as contagens desse tipo, devidas aos fótons provenientes de um objeto, dentro de 

uma região cujo tamanho delimita onde a contribuição da luz do objeto ainda é significativa. 

Isso é possível no DS9 utilizando-se o recurso Analysis > Pixel Table..., que abre uma 

janela suplementar e gera uma tabela quadrada de tamanho regulável onde são inseridos os 

valores de contagem em um certo número de píxeis em torno da posição do cursor. 

 

 

 

 

 

 

 

 

 
Figura 6: Descrição dos elementos que compõem a tabela de píxeis. 

Valores em azul delimitando as 
coordenasdas, em píxeis, na 

imagem. 

Tabela de píxeis 3x3 com 
os valores de contagens 

no píxel em que se 
encontra o ponteiro do 

mouse e no píxeis 
adjacentes 

Posição do ponteiro do 
mouse 

 

Para esta atividade, deve-se configurar o tamanho da tabela de píxeis acessando-se nela o 

menu Size > 9×9 (o que justifica o tamanho das regiões sobrepostas à imagem). 

A janela Pixel Table aumentará para conter novas linhas e colunas. Assim, dois 

inconvenientes podem ser percebidos: primeiro que a janela não fica em primeiro plano quando se 

passa o ponteiro do mouse sobre a imagem e segundo que os valores não ficam fixos numa dada 

posição de interesse, como são os objetos assinalados. 
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Figura 7: Aumentando o tamanho da tabela de píxeis. 

 

O primeiro problema acontece com a utilização do DS9 no Windows e pode ser parcialmente 

contornado se clicarmos com o botão direito do mouse sobre o ícone que representa sua janela na 

barra de tarefas. No entanto isto tem pouco interesse se não fixarmos a leitura da tabela de píxeis 

para uma dada região. 

 
O cursor em modo cruzado 
 

Para resolvermos o problema mencionado devemos utilizar o cursor em sua forma cruzada, 

acessando a opção Edit > Crosshair. Neste modo, clicando-se com o botão principal do mouse 

sobre uma região de interesse, um par de linhas perpendiculares entre si aparecerá sobre a 

imagem, e o ponto de cruzamento indica onde o ponteiro do mouse se encontrava no momento do 

clique. Se a tabela de píxeis estiver aberta, os valores de contagem no ponto de cruzamento serão 

enviados diretamente à tabela de píxeis e não se alterarão com o deslocamento do ponteiro do 

mouse sobre a imagem (se o botão principal não estiver clicado). 

 

 

Botões para habilitação do ponteiro do mouse em modo cruzado 

Cursor em modo 
cruzado Tabela de píxeis fixada 

na posição onde se 
clicou com o cursor 

cruzado

Com a tabela fixada, 
pode-se salvar um 

arquivo. 

Figura 8: Habilitação do cursor cruzado, seu aspecto e conseqüências. 
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Salvando uma tabela de contagens no local de um objeto de interesse 
 

Agora, com o tabela de píxeis fixada no local onde se clica sobre a imagem, podemos obter 

arquivos com os valores de contagens no local onde se encontra cada um dos objetos de interesse. 

Para isso proceda da seguinte forma: 

 

1-) Clique com o cursor cruzado bem ao centro de uma das regiões de interesse. A posição do 

cursor pode ser ajustada pelas setas do teclado; 

2-) Na janela Pixel Table, acessar a opção File > Save...; 

 

 
Figura 9: Centralizando o cursor cruzado no centro da região quadrada e acessando a opção File > Save da janela Pixel 
Table. A região quadrada tem a mesma dimensão que a tabela de píxeis, de forma que ela amostra o que será obtido na 

tabela, se o cursor estiver apropriadamente centralizado. 
 

3-) Será aberta uma caixa de diálogo solicitando o nome do arquivo a ser salvo. Utilize um nome 

que facilite a identificação do objeto que você está amostrando, conservando a extensão para 

tabela de píxeis (.pix); 

 

 

 

 

 
Figura 10: Salvando um arquivo com a 

tabela de píxeis em uma região de 
interesse. 
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Repita os procedimentos de 1-) a 3-) para todos os objetos. 

 

Salvando uma tabela de contagens avaliando o céu 
 

Sobre as contagens que avaliamos nos objetos de interesse, não há apenas contribuição dos 

fótons provenientes exclusivamente deles. Uma das principais contribuições que devem ser 

avaliadas é da própria emissão, reflexão ou espalhamento da luz no céu. 

Esse tipo de contribuição pode ocorrer de diversas maneiras, tendo efeitos locais e globais, 

além de depender de diversos fatores que a priori não temos informação. No entanto, podemos 

minimizar seu efeito, considerando que uma pequena região na imagem onde não há objetos (do 

tamanho equivalente ao tamanho da região em que amostramos os objetos de interesse) 

representa bem o céu sobre toda a imagem. 

Assim sendo, insira uma região quadrada como aquela usada para os objetos de interesse, 

denominando-a “céu” e coloque-a em uma região que atenda as condições mencionadas. Para isso 

será necessário mudar o ponteiro do mouse para o modo Pointer (Edit > Pointer). Não esqueça 

de salvar o arquivo de regiões com após adicionar esta. 

Volte com o ponteiro do mouse para o modo cursor cruzado e posicione-o centralizado com a 

nova região que amostra o céu. Repita os procedimentos de 1-) a 3-), mencionados na seção 

anterior, para assim gerar um arquivo com a tabela de contagens do céu. 

 

 
Figura 11: Região amostrando um local dominado pela emissão do céu. 

 
Obtendo as contagens associadas a uma região 
 

Não há, no momento, um recurso próprio do DS9 que permita avaliar o número de 

contagens de uma região. Este tipo de operação pode ser mais facilmente realizada em ambiente 
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Linux, incorporando recursos via Internet através da opção Analysis > Virtual 

Observatory... > Rutger/MIT X-ray Analysis Server ou compilando o programa FuntTools 

ou integrando o DS9 com os programas feitos em IRAF. 

Com o Windows, podemos utilizar outro programa para operar sobre os arquivos gerados na 

seção anterior, pois precisamos somar todas as contagens dentro de uma região e subtraí-la de 

todas as contagens somadas na mesma área, mais provenientes do céu. A partir disso será 

possível fazer todas as operações sugeridas no material auxiliar para obtenção das magnitudes 

das estrelas.  

Para isso preparamos uma planilha, no Excel, que permite a obtenção da fotometria dos 

objetos alvo que são o foco desta atividade. 

 
Planilha do Excel para obtenção da fotometria 
 

O arquivo que será usado para fazer a fotometria recebeu o nome 

TecnicasFotometricas.xls é contém 4 planilhas, denominadas Flux x Mag (com uma tabela 

relacionando o fluxo luminoso no filtro R (brilho) e a magnitude associada), Imagem1 (preparada 

para receber os dados das tabelas de píxeis feitas para imagem 1), Imagem2 (preparada para 

receber os dados das tabelas de píxeis feitas para imagem 2) e Calculos (com tabelas adequadas 

para realização dos cálculos da fotometria dos objetos). 

 

 

Planilhas 

  Figura 12: As quatro planilhas do arquivo TécnicasFotometricas.xls. 
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Inserção das tabelas de píxeis nas planilhas Imagem1 e 2. 
 

Para inserirmos os dados de contagens de cada um dos píxeis armazenados nas tabelas de 

píxeis, é necessário “importarmos” os arquivos .pix gerados para cada imagem da atividade, um a 

um. Isto é feito da mesma forma como foi feito para os arquivos gerados na atividade sobre as luas 

de Júpiter. 

Deve-se copiar a área correspondente aos dados de contagem das tabelas de píxeis e colá-las 

no arquivo TecnicasFotometricas.xls na planilha e tabela correspondentes ao objeto 

amostrado. 

 

  

Tabela de píxeis e tabelas 
correspondentes 

  Figura 13: Tabela de píxeis aberta pelo processo de importação do Excel, cujo conteúdo (excluindo a informação sobre 
as linhas e colunas da imagem onde foram extraídas) deve ser copiada para a tabela e planilhas correspondentes. 

 

Este processo deve ser repetido para cada um dos objetos das duas imagens. Note que a 

célula soma para estrela padrão não está preenchida para nenhuma das planilhas. Isto deve ser 

feito inserindo-se uma fórmula cuja sintaxe pode ser vista a seguir: 

 
=SOMA(B3:J11) ou =SUM(B3:J11) 

 
 
 

 
  Figura 14: Inserindo uma fórmula de soma para integrar todas as 

contagens no interior da região associada à estrela padrão. 
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No final do processo, tanto a planilha Imagem1 quanto a Imagem2 devem estar preenchidas 

como na figura a seguir: 

 

 
Figura 15: Aspecto das planilhas Imagem1 e Imagem2 depois de preenchidas. Os gráficos representam a distribuição de 

contagens dos objetos em função das coordenadas (= área da região amostrada). Note que o gráfico relativo ao céu é 
ruidoso, sem um padrão específico,  enquanto as estrelas apresentam um padrão de “gaussiana tridimensional”. 

 
Preenchendo a planilha de cálculos 
 

Os resultados preenchidos nas tabelas Imagem1 e Imagem2 são automaticamente 

redirecionados para a planilha Calculos. O que deve ser feito é estimar-se o número de contagens 

líquidas do objeto inserindo-se uma fórmula na coluna Líquido que é a diferença entre o número 

de contagens sobre objeto e o número de contagens sobre o céu. 

 

 

Campo de insersão de fórmulas 

Célula em que a fórmula 
está sendo inserida 

Figura 16: Inserindo a fórmula para calcular o número de contagens devidas exclusivamente aos objetos. 
 

Na coluna Brilho? e linha Padrão deve ser inserido o valor do brilho obtido na tabela de 

Fluxo x Magnitude, obtido para a magnitude conhecida da estrela padrão. Isto pode ser feito pela 

leitura direta da tabela ou por um ajuste que forneça uma expressão para calcular tal valor. 

O valor do brilho para as linhas Alvo 1 e Alvo 2  devem ser calculadas segundo a proporção 

que o brilho das estrelas alvo guardam com a estrela padrão. Ou seja: 
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Brilhoalvo = (Contagemalvo/Contagempadrão).Brilhopadrão 

 

A figura a seguir ilustra como isto é feito no Excel: 

 

 
Figura 17: Inserindo o brilho da estrela padrão e calculando o brilho das estrelas alvo. 

 

Com a informação dos brilhos de cada alvo, basta utilizar a tabela correlacionando o fluxo e 

a magnitude dos objetos de maneira inversa da que foi feita para estrela padrão, e preencher os 

valores de magnitudes derivadas para o filtro R.  

A mesma coisa deve ser feita para as tabelas da imagem 2. Ao final do processo, as tabelas 

de determinação das magnitudes no filtro R conterão os resultados da tarefa. 
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